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Introduction  
In a typical anti-virus deployment on a virtualized desktop infrastructure, full system scans need 
to be scheduled in such a manner so that all virtual machines underlying a Hypervisor do not start 
off with the scanning at about the same time causing a spike in input/output processing and CPU 
usage, thus rendering these virtual machines unusable for this span of time. This is known as AV-
Storming. 

McAfee® Optimized Virtual Environments (MOVE) for Servers solves this issue by connecting 
the ePolicy Orchestrator with the virtualized desktop infrastructure (provided by VMWare and 
Citrix) and by scattering the anti-virus scanning over a longer period such that the virtual 
machines remain useable during this time. MOVE for Servers is also integrated with the 
McAfee® VirusScan Offline Virtual Image scanner that allows scanning of virtual machines that 
are currently in the powered-off state.  

The following figure summarizes the MOVE for Servers deployment: 
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Installation Operations 

Overview 

This chapter describes the installation of McAfee® Optimized Virtual Environments (MOVE) for 
Servers. 

Product Components 

MOVE for Servers requires the following components be installed and running to provide and 
manage operations: 

 ePolicy Orchestrator server and repository: The management tool that installs client 
software, pushes out new policies, monitors client activity, creates reports, and stores and 
sends out content and client updates. 

 ePolicy Orchestrator agent (CMA Agent): The server agent installed on a client computer 
that acts as the intermediary between the client and the ePolicy Orchestrator console and 
database. It sends data to the client from the ePolicy Orchestrator server and vice versa. 

 VSE Extension: Provides the interface to the VirusScan Enterprise product in the ePolicy 
Orchestrator console. 

 VSE Agent: The component which provides anti-virus functionality for virtual machines. 

 MOVE Extension: Provides the interface to the MOVE products in the ePolicy 
Orchestrator console. 

 MOVE Agent: The component which provides scheduling functionality for powered-on 
virtual machines. 

If you want to schedule virus scan on powered-off virtual machines also, the following additional 
components are required: 

 VirusScan Enterprise for Offline Virtual Images: Provides the interface to schedule On 
Demand Scans on powered-off virtual machines. 

 OVI Extension: Provides the interface to powered-off virtual machines in the ePolicy 
Orchestrator console. 

Prerequisites 

1. An ePolicy Orchestrator management server version 4.5 Patch 1 (Build 851) or later 

For details on system requirements and instructions for setting up the ePolicy Orchestrator 
environment, see the ePolicy Orchestrator 4.5 Installation Guide. 

2. Target virtual machines with ePolicy Orchestrator 4.5 CMA installed 
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Before You Start 

Ensure the following before starting installation and configuration of MOVE for Servers: 

 Ensure that all end-point virtual machines have been added to ePolicy Orchestrator 
System Tree. 

 Ensure that McAfee VirusScan 8.7i Enterprise (Patch 2 or later) is installed on every end-
point virtual machine before deploying MOVE for Servers. In case, it is not installed, 
create a Product Deployment client task to install VSE on every end-point virtual 
machine. 

MOVE for Servers integrates with VirusScan Enterprise for Offline Virtual Images (VSE-OVI) to 
schedule on demand virus scan on powered-off virtual machines. MOVE integrates with VSE-
OVI version 2.0.1.  

Note: Version 2.0.1 of OVI was in Beta at the time of release of MOVE for Servers and was not 
available for download. Please contact McAfee Support for further assistance. 

If you want to schedule virus scan on powered-off virtual machines also, ensure the following: 

 Ensure that McAfee VirusScan Enterprise for Offline Virtual Images (OVI) 2.0.1 is 
installed on the dedicated machine where the OVI server is installed and is operational on 
the virtual machine images where off-line virtual image scan is required. Please refer to 
the OVI documentation for details. 

 Configure that scan start and scan complete events for OVI scans are also sent to the 
ePolicy Orchestrator: 

a) Log in to ePolicy Orchestrator console. 

b) Navigate to Configuration | Server Settings. 

c) Select Event Filtering in the left pane and then select edit. 

d) Now, select the following events to be sent: 

1335: Offline Virtual Image scan started (Info) 

1336: Offline Virtual Image scan completed (Info)  

e) Click Save. 

By default, the above events are not sent to the ePolicy Orchestrator console. Only scan 
failed events are scanned. All the three events (scan started, scan completed, and scan 
failed) are needed for scheduling OVI scans. 

MOVE for Servers Platform Support 

MOVE for Servers is available for the following virtualization platforms: 

 Xen Server 5.5 
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 VMware 4.0 

MOVE Agent is available for installation on the following platforms: 

 Windows 2003 Server (x86, AMD64) 

 Windows XP (x86, AMD64) 

 Windows Vista (x86, AMD64)  

 Windows 2008 Server (x86, AMD64)  

 Windows 2008 R2 (AMD64)  

 Windows 7 (x86, AMD64)  

Installation and Configuration Steps 

Download MOVE for Servers Packages 

Download the MOVE for Servers software package (MOVE-SRV-1.5.0.zip) and MOVE for 
Servers documentation package (MOVE-SRV_docs.zip) from the McAfee download site.  

The MOVE for Servers software package (MOVE-SRV-1.5.0.zip) contains the following: 

a) MOVE Agent Deployment Package (MOVE-SRV_Agent_1500_WIN.zip)  

b) MOVE Extension for ePolicy Orchestrator (MOVE-SRV_Ext_1.5.0.zip) 

To schedule on demand virus scans on powered-off virtual machines, download the VSE-OVI 
version 2.0.1 software package and see the OVI Installation Guide for installation details. 

Note: Version 2.0.1 of OVI was under Beta at the time of release of MOVE for Servers and is not 
available for download. Please contact McAfee Support for further assistance. 

Install the MOVE Extension package 

Use this procedure to install the MOVE Extension package. The extension must be installed 
before ePolicy Orchestrator can manage MOVE products. 

1. Ensure that the extension file is in an accessible location on the network. 

2. From the ePolicy Orchestrator console, select Menu | Software | Extensions. 

3. The Extensions page opens, click Install Extension. 

4. Browse to and select the MOVE-SRV_Ext_1.5.0.zip file. 

5. Click OK. 

6. Verify that the MOVE product name appears in the Extensions list. 
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Add Registered Servers 

Use this procedure to a Registered Server in ePolicy Orchestrator: 

NOTE: The procedure described below is for VMware vCenter. The procedure for adding Citrix 
XenPool is same; just select Xen Pool as Server type. 

1. From the ePolicy Orchestrator console, select Menu | Configuration | Registered Servers. 

2. The Registered Servers page opens. Click New Server. 

3. Select Server type as VMware vCenter. 

NOTE: To add a Citrix XenPool Hypervisor, select Xen Pool as Server type. 

4. Type the name of the Registered Server, for example, Test vCenter and add any descriptive 
information to the Notes field. 

5. Click Next. Registered Server Details page is displayed. 

6. Select https or http in the Protocol field as per the protocol on which VMware vCenter is 
expecting client requests. 

7. Provide the VMware vCenter hostname or IP-address in Server field. 

8. Specify the credentials to connect with VMware vCenter in the User and Password fields. 

9. Click Test Connection to validate the input parameters. 

Test Connection Success message is displayed if ePolicy Orchestrator is able to connect to 
the specified VMware vCenter.  

10. Click Save. 

Add the MOVE Agent Deployment Package to the ePolicy Orchestrator 
repository 

Use the following procedure to add the MOVE Agent deployment package into the ePolicy 
Orchestrator software repository. 

1. Select Menu | Software | Master Repository. The Packages in the Master Repository page 
appears. 

2. Select Actions | Check In Package. 

3. Select the package type as Product or Update (.ZIP). 

4. Browse to and select the MOVE_Agent_1500_WIN.zip file. 

5. Click Next. The Package Options page appears. 
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6. Confirm the following: 

 Package Info: Confirm that this is the correct package. 

 Branch: Select the desired branch - current for new products. 

 Package signing: This specifies if the package is signed by McAfee or is a third-
party package. 

7. Click Save to begin checking in the package. Wait while the package is checked in. 

The new package appears in Packages in Master Repository list on the Master Repository tab. 

Install MOVE Agent on virtual machines 

Use this procedure to add a client task to install the MOVE Agent on the virtual machine clients. 

1. Select an appropriate group in the System. 

NOTE: It is recommended that you create the installation client task at the My Organization 
level and apply it on only those machines tagged as virtual machines (VM). 

2. Select Menu | Systems | System Tree | Client Tasks. Then click New Task. 

3. The Client Task Builder - 1 Description page appears. 

4. Type the name of the task, for example, Install MOVE Agent on VM client and add any 
descriptive information to the Notes field. 

5. Select Product Deployment from the Type drop-down menu.  

6. Select Send this task to only computers which have the following criteria:. Then, click 
edit link for Has any of these tags. The Edit Included Tags dialog appears. Add the VM 
tag and click OK. 

7. You return to the Client Task Builder - 1 Description page. 

8. Click Next. The Client Task Builder - 2 Configuration page appears. 

9. Next to Target platforms, select Windows. 

10. From the Products and components list, select the MOVE Agent 1.5.0.12 and then: 

a) Set the Action to Install. 

b) Set the Language to Language Neutral. 

c) Set Branch to Current. 

11. Click Next. The Client Task Builder - 3 Schedule page appears. 

12. Select Enabled for the schedule status. 
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13. From the Schedule type list, select the appropriate schedule. To deploy immediately, select 
Run Immediately. 

14. Set the other schedule settings as required. 

15. Click Next. The Client Task Builder - 4 Summary page appears 

16. Review and verify the details, then click Save. 

17. If you scheduled the task to run immediately, perform an agent wake-up call. 

To confirm that the MOVE Agent has been successfully installed, check the System 
Information and MOVE properties reported to the ePolicy Orchestrator console. For details, 
see the ePolicy Orchestrator Product Guide. 

Uninstall MOVE for Servers Components 

Uninstall the MOVE Extension 

Use the following steps to uninstall the MOVE Extension: 

1. Select Menu | Software | Extensions. The Extensions page opens. 

2. From the Extensions tab under McAfee group, select MOVE. 

3. Click Remove. 

Uninstall MOVE Agent from Virtual Machines 

Use this procedure to uninstall the MOVE Agent on the virtual machine clients. 

1. Select an appropriate group in the System. 

NOTE: It is recommended that you create the un-installation client task at the My 
Organization level and apply it on only those machines tagged as virtual machines (VM). 

2. Select Menu | Systems | System Tree | Client Tasks. Then click New Task. 

3. The Client Task Builder - 1 Description page appears. 

4. Type the name of the task, for example, Uninstall MOVE Agent from VM clients and add 
any descriptive information to the Notes field. 

5. Select Product Deployment from the Type drop-down menu. 

6. Select Send this task to only computers which have the following criteria:. Then, click 
edit link for Has any of these tags. The Edit Included Tags dialog appears. Add the VM 
tag and click OK. 

7. Click Next. The Client Task Builder - 2 Configuration page appears. 
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8 

8. Next to Target platforms, select Windows. 

9. From the Products and components list, select the MOVE Agent 1.5.0.12 and then: 

a) Set the Action to Remove. 

b) Set the Language to English. 

c) Set Branch to Current. 

10. Click Next. The Client Task Builder - 3 Schedule page appears. 

11. Select Enabled for the schedule status. 

12. From the Schedule type list, select the appropriate schedule. To deploy immediately, select 
Run Immediately. 

13. Click Next. The Client Task Builder - 4 Summary page appears 

14. Review and verify the details, then click Save. 

15. If you scheduled the task to run immediately, perform an agent wake-up call. 

16. To confirm that the MOVE Agent has been successfully uninstalled, check that MOVE 
properties are no longer present in the System information page. 
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